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Моя роль у груповій праці 
 

 
 
 
Моя роль у групі:   

 . 
 
Я відповідальний/відповідальна за: 

•   

•   

•   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Найтяжча частина моєї роботи, це  . 
 
 
Найкраща частина моєї роботи, це . 
 
 
Моя праця була  . 
 відмінною, дуже доброю, вирішальною, незадовільною 
 
 
 
 
 
 
  

Reproduced from Alberta Learning, Kindergarten to Grade 9 Health and Life Skills Guide to Implementation (Edmonton, 
AB: Alberta Learning, 2002), p. C.31. 
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Як я можу допомогти своїй групі 
 
 
 
Ім’я:   Дата:   
 
Під час групової праці, коли хтось: 
 
 перебиває, я почуваю себе  
 
 Щоб покращити ситуацію, я можу   

 сперечається, я почуваю себе   
 
 Щоб покращити ситуацію, я можу   

 принижує інших, я почуваю себе   
 
 Щоб покращити ситуацію, я можу   

 нарікає, я почуваю себе   
 
 Щоб покращити ситуацію, я можу   

 не працює, я почуваю себе   
 
 Щоб покращити ситуацію, я можу   

 постійно наказує іншим, я почуваю себе   
 
 Щоб покращити ситуацію, я можу  

 не слухає інших, я почуваю себе   
 
 Щоб покращити ситуацію, я можу   

 незосереджений, я почуваю себе   
 
 Щоб покращити ситуацію, я можу   

 дуже тихий, я почуваю себе   
 
 Щоб покращити ситуацію, я можу   

 
  

Reproduced from Alberta Learning, Kindergarten to Grade 9 Health and Life Skills Guide to Implementation (Edmonton, 
AB: Alberta Learning, 2002), p. C.33. 
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Оцінювання своїх дій 
 

 
 
Ім’я:   
 
Дата:   
 
Тема:   
 
 

Що ми робили? Які наші результати? 

 
 
 
 
 
 
 
 

 

Що ми можемо робити тепер? 
 
 
 
 
 
 

Найважливіші речі, яких я навчився/навчилася 
 
 
 
 
 
 

Як я зможу вживати нову інформацію і навички з цього розділу у майбутньому? 
 
 
 
 
 
 

 
  
Adapted with permission from Eric MacInnis, Ross MacDonald and Lynn Scott, Controversy as a Teaching Tool (Rocky 
Mountain House, AB: Parks Canada, 1997), pp. 74, 75. 
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Збірка моїх думок 
 

 
 
Ім’я:   Дата:   
 
Все, що я знаю про   

  

  

  

  

  
 
 
Ось декілька малюнків   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

 
 
Мої запитання:   
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How to Use KWL Charts 
 

 
 

Think about what you already KNOW about your topic. List those 
facts in the first column. 

 
For example, if your topic is “How I Talk to Others in a New Language,” you may come 
up with these ideas. 
 

What I know What I want to find out What I have learned 

• Can use hand gestures 
and facial expressions 
to help the other 
person understand 

• Don’t be afraid to 
make mistakes!  

  

 
 

Think of the kinds of information you WANT to find out.  List specific 
questions in the second column. 

 

What I know What I want to find out What I have learned 

• Can use hand gestures 
and facial expressions 
to help the other 
person understand 

• Don’t be afraid to 
make mistakes! 

• What to do if I don’t 
know how to say a 
word 

• What to do if I don’t 
understand what the 
other person is saying 

 

 
 

LEARN the answers to your questions. List that information, and 
anything else that you learn about your topic, in the third column. 

 

Step 1 

Step 2 

Step 3 

 

MS Word allows you to create your own chart electronically using 
the options in the Table menu. 
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How to Use a Brainstorming Web 
 

 
 

 

Identify your topic and use it as the title. Write it in the centre of your web. 
 

 
 
Identify categories of information and label each of the outer bubbles. 
 

 
 
Brainstorm and jot down ideas in each category. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Step 1 

Step 2 

Step 3 

Тема 

Ідеї 

Ідеї 

Ідеї 

Ідеї 

Ідеї Ідеї 

 

Newer versions of MS Word have a web-building option listed under 
Diagram on the Insert menu that lets you create your own web 
electronically. 
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Мозкова атака 
 

 
 
Ім’я:   Дата:   
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Створюємо ідеї 
 

 
 

1. Головна ідея 

  

 
3. Факти 

  

  

  

  

  
2. Намалюй  

  
 

4. Зразкове речення 

  

  

  

  

 
5. Зразки 

  

  

  

 
 

 

 

6. Необхідні зразки 

  

  

  

 
7. Значення 

  

  

 
  
Reproduced with permission from Edmonton Public Schools, Thinking Tools for Kids:  Practical Organizers (Edmonton, AB: 
Resource Development Services, Edmonton Public Schools, 1999), p. 178. 
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How to Use a Mind Map  
 

 
 

Identify a topic and use it as the title.  Write the word or draw a picture in 
the centre of your mind map. 
 
Identify categories of information and label or draw a picture in each of 
the outer bubbles. 
 
 

Create subcategories of information to expand on your mind map. 
 

 
Use as many pictures, colours, imagery and key words as you can to 
create your mind map. 

 
 
 

 
 
  
From Alberta Learning, Kindergarten to Grade 9 Health and Life Skills Guide to Implementation (Edmonton, AB: Alberta 
Learning, 2002), p. 93. 

 

 
Me 

 

 

How I 
learn best  

 

  

Believing 
it’s important  

Caring 
about it 

 

 Read about it 

Time to think 

 

 
  

   

 

Write about it 

 

 

Discuss 

 

 

Why? 

  

 

Why 
not? 

Step 1 

Step 2 

Step 3 

Step 4 
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How to Use Venn Diagrams 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Label each side of the diagram with the name of each item you are 
comparing. 

 
 

Think about all the unique features or characteristics of the first item 
and write your ideas in the left part of the diagram. 

 
 

Think about all the unique features or characteristics of the second 
item and write your ideas in the right part of the diagram. 

 
 

Think about all the features the items share and write your ideas 
in the middle of the diagram. 
 

Characteristics or features 
that are the same for 
both items 

Characteristics or 
features that are 
unique to another 
item 

Characteristics or 
features that are 
unique to one 
item 

Step 1 

Step 2 

Step 3 

Step 4 

 

Newer versions of MS Word have a Venn diagram option listed 
under Diagram on the Insert menu that lets you build your own Venn 
diagram electronically. 

 

 

 

 



  

Д
іа

гр
ам

а 
Ве

нн
а 

 

  Ім
’я

:  
 

Д
а

та
:  
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Мої п’ять органів чуття 
 

 
 
Ім’я:   Дата:   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Тема 

нюх 
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Таблиця-схема 
 

 
 
Ім’я:   Дата:   
 
 
Тема:   
 

Виглядає, як: Звучить, як: Відчувається, ніби: 
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Питальні слова 
 

 
 
Ім’я:   Дата:   
 
 
Напиши в таблицю запитання, на які ти хочеш отримати відповіді. 
 

Хто? 
 
Напиши запитання 
про людей. 

 

Що? 
 
Напиши запитання 
про речі і події. 

 

Де? 
 
Напиши запитання 
про місця. 

 

Коли? 
 
Напиши запитання 
про час і дату. 

 

Чому? 
 
Напиши запитання 
про причину, мету. 

 

Як? 
 
Напиши запитання 
про те, як стаються 
речі. 

 

Якщо? 
 
Напиши запитання 
про речі, які б 
могли статися. 

 

 

 



  

Д
ен

ь 
у 

ж
ит

ті 
   Ім

’я
:  

 
Д

а
та

:  
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How to Use PMI Charts 
Таблиця П–М–Ц (Плюс–Мінуc-Цікаво) 

 
 

Plus: think about all the advantages and good reasons for making the 
choice. 
 

 
Minus: think about all the disadvantages and the down side of making 
the choice. 
 
 
List any information that is neither positive nor negative as Interesting. 

 

 
 
Example: A PMI chart that shows the advantages and disadvantages of using the 

Internet as a research tool 
 

Using the Internet as a Research Tool 
 

Plus Minus Interesting Information 
 
• There is a lot of 

information. 
 
• You can look at a 

number of different 
sources in a short 
period of time. 

 
• You can do your 

research in the 
comfort of your home 
or classroom. 

 
• If you do not know 

how to search well, it 
can take a long time 
to find what you 
need. 

 
• There is no guarantee 

that the information 
you find is accurate 
or of good quality. 

 
• The reading level of 

factual and historical 
information may be 
high. 

 

 
• Most teenagers know 

more about using the 
Internet than adults! 

 
• Anybody can post 

information on the 
Internet.  There are no 
rules to follow, no licenses, 
etc. 

 
 
 
 
 
 

Step 1 

Step 2 

Step 3 

 

MS Word allows you to create your own chart electronically using 
the options in the Table menu. 
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Приймаю рішення: 
Що я маю, що мені треба 

 

 
 
Яка проблема? 
 
 

 
 
Який мій вибір? 
A. B. C. 
 
 

 
 

Який вибір мені найкраще підходить? 
 
 

 
 
Які ресурси я маю? 
1. 
2. 
3. 

 
 

Які ресурси мені треба? 
1. 
2. 
3. 

 
 

План крок за кроком 
1. 
2. 
3. 

 
 

Як можна перевірити моє рішення? 
 
 

 
  
Reproduced with permission from Edmonton Public Schools, Thinking Tools for Kids:  Practical Organizers (Edmonton, AB: 
Resource Development Services, Edmonton Public Schools, 1999), p. 232. 
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Приймаю рішення 
 

 
 
Проблема:   Вибір:   
 
 Позитивні + Негативні – 

Факти:   

  

  

  

  

  

  

  

  

  

  

  

 

Почуття:   

  

  

  

  

  

  

  

 

Мої нові ідеї:   

  

  

  

  

  

  

  

  

  

 

Мої рішення:   

  

 

Причини, які 
допомогли мені 
вирішити: 

  

  

 
  

Adapted with permission from Eric MacInnis, Ross MacDonald and Lynn Scott, Controversy as a Teaching Tool (Rocky 
Mountain House, AB: Parks Canada, 1997), p. 61. 
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IDEA Decision Maker 
 

 
 
 
 
 
 
 dentify the problem 

   

   
 
 escribe possible solutions 
  

A B C 
   

 
valuate the potential consequences 
of each solution 

 
   

 
ct on the best solution 

  
 
 
 
 
 
 
 
 
 
 
 
How did your IDEA work? 
(Evaluate your results.) 

  

  

I 
 
 
 

D 
 
 
 
 
 
 

E 
 
 
 
 
 
 

A 
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Розглянь альтернативи 
 

 
 
Проблема, яку треба вирішити:   

  

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Можливі наслідки:   

  

  

  

Вибір:   

  

  

  

1 

Можливі наслідки:   

  

  

  

4 Вибір:   

  

  

  

Можливі наслідки:   

  

  

  

3 Вибір:   

  

  

  

Можливі наслідки:   

  

  

  

2 Вибір:   
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Influences on Decision Making 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Questions you need to ask to help you make this decision 

    

    

    

    

Decision to be made 

  

  

  

  

Family Peers 

Cultural beliefs Values 
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Мета і планування 1 
 

 
 
Ім’я:   Дата:   
 
 
План 
 
 
Моя мета   

  

  
 
 
Я вибираю цю мету, тому що 

  

  
 
 
Щоб досягнути моєї мети, я буду: 
 
 
 
1.   
 
 
 
2.   
 
 
 
3.   
 
 
Мені треба _______ днів, щоб досягнути мети. 
 
Чи я досягнув/ла мети?  так 
   

  майже 
   

  ні 
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Мета і планування 2 
 

 
 
Дата:   
 
Ім’я:   
 
 

Мета Моя мета … 
 
 
 
 

Пояснення Я це вибрав/вибрала тому, що … 
 
 
 
 
 

Плянування дії Щоб досягнути цієї мети, я … 
 
 
 
 
 
 
 
 
 

Міра 
плянування 

Як я дізнаюся, чи я успішно досягнув/досягнула мети? 
 
 
 
 
 
 

Міркування 
про себе 

Щоб я зробив/зробила інакше? 
 
 
 
 
 
 

Чи твоя мета: 
 конкретна? 
 піддається  

оцінці? 
 досяжна? 
 реальна? 
 має часовий 

вимір? 
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Мета і планування 3 
 

 
 
Ім’я:   Дата:   
 
 

Планування мети 
 
 
Моя мета на майбутнє   

  до   
 
 
Кроки, які допоможуть мені досягнути мети: 
 

Крок А  Крок Б  Крок C 

  

  

   

  

   

  

 
Для досягнення мети, я:  Для досягнення мети, я:  Для досягнення мети, я: 

•   

•   

•   

до   

 

 •   

•   

•   

до   

 

 •   

•   

•   

до   

 
 
 
 
 
 
 
 
 
 
 
 
Я знатиму, що я досягнув/досягнула майбутньї мету тоді, коли   
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Мета і планування 4 
 

 
 
Ім’я:   Дата:   
 
 

Що може вплинути на досягнення мети? 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Мета 
 
  
 
  
 
  

 
 

 
 

 

 




